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The Oracle Purchasing 11i Connector for RightFax

The Oracle Purchasing 11i Connector for RightFax lets you send How the Oracle Purchasing 11i

purchase orders, releases, and change orders from the Oracle

Purchasing 11i application, a component of the Oracle E-Business Connector Works

Suite, via your RightFax server. With the Connector, you can: The Oracle Purchasing 11i Connector for RightFax fax- and

« Send documents as faxes or e-mails. email-enables Oracle Purchasing 11i by intercepting data from the

print stream sent from Oracle. The connector affixes elements of

¢ Reduce the cost of delivering documents to customers and the RightFax Facsimile Command Language (FCL) to the

vendors. document data, checks FCL syntax, and then faxes or emails the
¢ Replace manual mailing or faxing. document.
o More efficiently utilize employee resources.
« Eliminate the need to install and manage multiple stand-alone fax Sending documents from Oracle 11i

machines. The Oracle Purchasing 11i user interface contains a Fax Number
¢ Increase control over your document delivery strategy. text box where a user can type a recipient fax number. The user can
« Eliminate missed deadlines for critical path purchases. also enter an email address in this text box. The Oracle Purchasing

11i Connector uses this fax number or email address to send the

o Reduce lost revenue due to increased days sales outstanding. document to a recipient

¢ Minimize implementation times and interface cost.

Using This Guide

The Oracle Purchasing 11i Connector Guide is designed for
RightFax administrators and contains an overview of the Connector
including information on configuring document templates and
notifications. It is a reference guide, with introductions to and
overviews of technical topics. This guide is intended to be used
with the RightFax Integration Module Guide, and it is supplemental
to Captaris technical training classes.
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When a document is sent as email, it is attached as a TIFF image to
an empty email message. The subject line of the email message is
“E-Document,” and the sender's e-mail address is

admin@tcp/ip domain, where tcp/ip domain is the following value
in the Windows Registry:

HKLM\System\CurrentControlSet\Services\Tcpip\Parameters
\Domain

or

HKLM\System\CurrentControlSet\Services\Tcpip\Parameters
\DhcpDomain

To notify an administrator or the sender when an email address is
invalid, you have the following options:

o Send a message that notifies the sender that the email address is
invalid.
¢ Print or fax the document to another recipient.

To send documents as email, you must license and activate the
RightFax Enterprise Integration Module.

Understanding document templates

The print stream that is sent to RightFax from Oracle Purchasing
11iincludes a {{doctype}} FCL code. This code identifies the
document type (such as a purchase order, release, or change
order), and RightFax provides a document template for each
document type. These templates define the layout of each type of
document, including information such as text margins and fonts.

The following is an outline of the data flow process between the
Oracle and RightFax servers

1. Print output is sent from Oracle Purchasing 11i to the RightFax
server.

2. RightFax detects the {{doctype}} FCL command and accesses
the relevant document template.
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3. FCL in the document template is added to original Oracle
document.

4. RightFax re-formats and transmits the document based on
FCL-defined parameters in the document template.

You can customize the default document templates by:

¢ Placing graphics, such as logos, on the template.

¢ Including background forms, such as a purchase order form.
« Specifying a cover sheet to send with each document.

o Setting margins and fonts, choosing a printer, and changing the
page orientation.

o Configuring documents to be printed, faxed, or e-mailed.

« Specifying a notification method and notification templates.
¢ Adding FCL to the template.

¢ Re-naming the templates.

Activating the Oracle Purchasing 11i Connector

The files required by the Oracle Purchasing 11i Connector for
RightFax are installed on all RightFax servers during the server
installation. However, the Oracle Purchasing 11i Connector must
be licensed and activated before its functionality will be enabled.

To activate the Oracle Purchasing 11i Connector, you must have
licensed a RightFax server type that includes this connector, or
purchased and licensed this connector separately. For information
on activating new components on the RightFax server, refer to the
RightFax Installation Guide.

After the Oracle Purchasing 11i Connector for RightFax has been
activated on the RightFax server, you must customize the default
document templates to appear as you need (described in the next
section).



Editing the Default Templates

The default settings in the templates are the default values
established in the Integration Module Configuration program (as
described in the RightFax Integration Module Guide). When you
edit the templates, the settings you make override the defaults.

Do not create new templates. Only the default templates for a
change order, a purchase order, and a release are supported.

Warning Do not delete the default document templates.

To edit a document template

1. On the RightFax server in Windows Explorer, navigate to
RightFax\Production\Bin and run ERPConnector.exe. This
opens the Oracle Purchasing 11i Connector window.

Figure 0.1 The Oracle Purchasing 11i Connector Window
]
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. To re-name a template in the Template Name list, select the

name, click Rename, and enter the new name. This changes the
name that appears in the display only. It does not change the file
name.

3. In the Template Name list, select the template to edit.

4. Click Edit. The edit dialog box appears in the right pane of the

window. You have the following options:

e “Adding a graphic image or a background form” (described
on page 6.)

¢ “Adding a cover sheet” (described on page 6.)

e “Configuring the layout” (described on page 7.)

o “Faxing a copy of a document that was transmitted”
(described on page 7.)

o “Faxing a copy of a document that cannot be transmitted”
(described on page 8.)

¢ “Specifying the notification method” (described on page 9.)
e ‘“Adding FCL code to the template” (described on page 9.)

. Select File > Save, or click the save icon on the toolbar.

The Oracle Purchasing 11i Connector for RightFax

5



Adding a graphic image or a background form

For more information about placing graphics and background
forms in FCL documents, see the RightFax Integration Module
Guide.

1. Click the Forms tab.

Figure 0.2 The Forms tab
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2. In the Form File box, enter the path to the background form to
include with the document.

3. To specify the position of the upper-left corner of the
background form, select the Place at Position check box. The
default is 0,0 from the top-right corner of the document.

4. In the Horizontal Shift and Vertical Shift boxes, enter the x-
and y-coordinates for the upper-left corner of the background
form.

5. In the Logo File box, enter the path to a graphic to appear in the
document.
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6. To specify the position of the upper-left corner of the
background form, select the Place at Position check box. The
default is 0,0.

7. In the Horizontal Shift and Vertical Shift boxes, enter the x-
and y-coordinates for the upper-left corner of the graphic.

Adding a cover sheet
1. Click the Cover Page tab.

Figure 0.3 The Cover Page tab
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2. In the Cover File box, enter the path to the cover sheet file to
include with the fax.



Configuring the layout Faxing a copy of a document that was transmitted

1. Click the Layout tab. 1. Click the On Success tab.
Figure 0.4 The Layout tab Figure 0.5 The On Success tab
x x
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2. In the Name list, click the font name.

3. In the Points of Leading box, enter the value (to 1000t of an
inch) for the vertical spacing of the font.

4. In the Pitch box, enter the value (to 1000 of an inch) for the
horizontal spacing of the font.

5. In the Top, Left, and Bottom boxes, enter the width of the page
margins.

6. Click Default, Portrait, or Landscape to specify the orientation
of the page.

7. In the RightFax Printer box, enter the name of the a printer
defined in Enterprise Fax Manager. This creates a default printer
for documents that use the document template that you are
creating.
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2. Select one of the following options. Faxing a copy of a document that cannot be transmitted
1. Click the On Error tab.
Option Description
) . Figure 0.6 The On Error tab
Default Performs the default action specified in the
Integration Module Configuration program. e —
Layout I Forms | Cover Page I Motify |
Nothlng NO aCtiOn will be taken, On Success On Error | Custom FCL
Fax Fax the document to another recipient. -
othing
¢ To send the fax to the default number  Dekele
specified in the Integration Module ~ Fan
Configuration program, click Fax to Default ) ot D efault Py Nurber
Fax Number € Far to Number:

™| Fax First Page. Orly

o To specify the fax number, click Fax to B o e Fihe

Number. Enter the fax number. If you are
using the Enterprise Integration Module, you
can enter an e-mail address.

¢ To send only the first page of the document,
select the Fax First Page Only check box.

¢ To delete the fax image from the fax server
after transmission, select the Delete Fax
when Finished check box.




2. Select one of the following options.

Option Description

Default Performs the default action specified in the
Integration Module Configuration program.

Nothing No action will be taken.

Fax Fax the document to another recipient.

¢ To send the fax to the default number specified
in the Integration Module Configuration
program, click Fax to Default Fax Number.

¢ To specify the fax number, click Fax to
Number. Enter the fax number. If you are using
the Enterprise Integration Module, you can
enter an e-mail address.

¢ To send only the first page of the document,
select the Fax First Page Only check box.

¢ To delete the fax image from the fax server
after transmission, select the Delete Fax
when Finished check box.

Specifying the notification method

Methods for sending notification messages to a host application
are configured in the Integration Module Configuration program.
For information and instructions, see the RightFax Integration
Module Guide.

Notification messages, including templates, are determined by the
{{notifyhost}} FCL code. For more information on notification
messages, see the RightFax Integration Module Guide.

1. Click the Notify tab.

Figure 0.7 The Notify tab
X
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Layout I Foims I Cover Page Motify

Natification Methad

(Mone] j

Successful Template Unsuccessful Template

|[N0ne] j |[N0ne] j

2. In the Notification Method list, select a notification option. The
options in this list are created in the Integration Module
Configuration program.

3. In the Successful Template list, select the template for
notification messages about successful transmissions.

4. In the Unsuccessful Template list, select the template for
notification messages about failed transmission attempts.

Adding FCL code to the template

You can extend the template by adding FCL code. The complete
list of FCL codes, their syntax, and the placement of codes within
documents is provided in the RightFax Integration Module Guide.
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1. Click the Custom FCL tab.

Figure 0.8 The Custom FCL tab
X
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WARMIMNG: Improper FCL commands can cause document Failure

FCL Commands to be inserted before document text:

{iNOTE Oracle Template}} ;I
[

FCL Commands to be inserted after document text:

[ =l
[

2. In the FCL commands to be inserted before document text
box, type the FCL codes.

3. In the FCL commands to be inserted after document text
box, enter FCL codes.
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